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EDITORIAL

Welcome to another issue of Full Circle!

e have a whole new section for you this month. As promised, I've begun writing

'Closing Windows'. It'll be a series of articles that will fFocus on a feature from

Windows (XP in this case), then show where that feature is, or how it can be

obtained, in Ghome, Unity, KDE, LXDE and XFCE. So, no matter which *buntu you
use, this series should help complete beginners. My thanks go to my co-authors on this series.
Their names are at the start of this First part, which focuses on My Computer and Windows' file
manager, Explorer.

Unfortunately, Elmer is a bit busy this month, so there's no LibreOffice article, but he'll be
back next month. In his place is a brief How-To on using FreeMind, the mind-mapping tool. If
you've never used a mind-map before, then you're missing out on a great idea tool. As well as
the usual serialised articles, we have an article on using Apt-Cache-NG. It will allow you to
update serveral machines from one set of downloaded .deb Ffiles. Very handy! The final part of
my ZoneMinder series will show you how to include/exclude certain areas of a camera view. It's
a very powerful feature, and one that will save you from getting a lot of false positives. Next
month's Linux Labs will hopefully have an article on setting up your own voice over IP (VOIP)
bits.

One last thing: last month | gave the Italian translation team the honor of being the only
team to have translated all issues of FCM. Sorry Italian team, but the Hungarian team have also
translated all issues now. Congratulations to you both. Who else is ready to step up and
translate the entire back catalogue?

All the best, and keep in touch.
Ronnie
ronnie@fullcirclemagazine.org
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Full Circle Podcast

Released every two weeks, each
episode covers all the latest
Ubuntu news, opinions, reviews,
interviews and listener feedback.
The Side-Pod is a new addition,
it's an extra (irregular) short-form
podcast which is intended to be a
branch of the main podcast. It's
somewhere to put all the general
technology and non-Ubuntu stuff
that doesn’t fit in the main
podcast.

Hosts:

Robin Catling
Ed Hewitt
Dave Wilkins

http://fullcirclemagazine.org
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LINUX NEWS

BMW May Use Linux In
Cars

erman car maker BMW
spoke about how it might
use Linux for in-car
entertainment.

In a panel on providing high
performance [...] we could see
Linux being adopted for use in car
entertainment systems in future
BMW vehicles.

Andreas Poschl, an IT Specialist
at BMW said, "We are looking into
Linux for the car. We also see the
possibility of Linux in the car,
especially for the entertainment.”

The firm uses Linux [since 2003]
for mission critical systems such as
its large servers.

Poschl said, "We are doing
business critical stuff with Linux.
Linux is high quality, high
performance, flexible."”

Source: theinquirer.net

Ubuntu Turns 7,
'Precise Pangolin'
Planning Begins

t was exactly seven years ago

that the very first version of

Ubuntu Linux--dubbed “Warty

Warthog"”--was released,
kicking off a long line of
increasingly popular versions of
the free and open source
operating system.

Fast forward to today, and
Canonical is wasting no time
moving from last week's release of
Ubuntu 11.10 “Oneiric Ocelot” into
planning for the next version, also
known as “Precise Pangolin.”

Perhaps most notable about
Precise Pangolin is that it will be
Ubuntu's fourth Long Term
Support (LTS) release, with a full
three years of support.

Source: pcworld.com

Puppy Linux 5.3
"Slacko" based on
Slackware 13.37

he Puppy Linux developers

have announced the

release of version 5.3 of

their independent Linux
distribution, a new edition code-
named "Slacko". According to
Puppy Linux founder Barry Kauler,
Slacko Puppy (coordinated by Mick
Amadio) is to be the project's "new
flagship Puppy Linux"and is the
recommended "first stop’ for all
newcomers".

Slacko was built using the Woof
build tool, which can build a Puppy
release from the binary packages
of any other distribution. Slacko
Puppy 5.3 is based on Slackware
Linux 13.37 binary packages and
the 2.6.37.6 Linux kernel, and
includes access to the Slackware
package repositories. Other
software can be installed via PET
packages and packages in the
Slackware repositories.

Source: h-online.com
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OBITUARY

Dennis

MacAlistair

Ritchie (b.

September 9,

1941; found dead

L \.! October 12,

2011), commonly known by his
username dmr, was an American
computer scientist who "helped
shape the digital era." He created
the C programming language
and, with long-time colleague,
Ken Thompson, the UNIX
operating system. Ritchie and
Thompson received the Turing
Award from the ACM in 1983, the
Hamming Medal from the IEEE in
1990 and the National Medal of
Technology from President
Clinton in 1999. Ritchie was the
head of Lucent Technologies
System Software Research
Department when he retired in
2007. The 'R' of the K&R C book
stands for his name.

See:
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COMMAND) & CONQUER

Written by Lucas Westermann

Vim and Gvim

e

n the process of configuring

ArchLinux on a PC, | realized

just how much more efficiently

| work in Vim than I do in any
other text editor. So, when Article
Day rolled around, | checked to see
if there had been an article on Vim.
Lo and behold, there was only a
brief introduction to Vim. To start
with, I should probably
differentiate a text editor from an
office suite like
OpenOffice/LibreOffice. A text
editor is used for editing stuff like
* bxt, *.rtf, *.conf, *~, and basically
any other plain text document
format (i.e. no formatting). An
office suite, on the other hand,
works on *.doc and *.odt files
(among others). | usually use plain
text documents for quick to-do
lists, and for writing code. I'm Fairly
certain there are many of you out
there who either write quick notes
to themselves, write code (be it
software or websites), and perhaps
edit some configuration files.

What's the difference between
Vim and GVim?

Vim is the console-oriented

version of the program (for use in
gnome-terminal, rxvt-unicode, tty
screens, and so forth). GVim is a
graphical front-end for Vim, and
allows easy access to some of the
more esoteric commands.

Why should | use Vim/GVim?

I'm not going to say that
Vim/GVim is the only text editor
anyone should use, but it's the one
| prefer. Why do | prefer it? Simply
because it offers sane defaults and
keybindings that allow for very
quick editing - without the need for
a mouse. | find that keeping my
hands on my keyboard actually
allows for Faster work than pausing
to move the mouse (or keeping a
hand on the mouse most of the
time). If you find yourself nodding
along with this, you should give
Vim/GVim a shot. For example: Say
you wanted to delete 250
sequential lines in some source
code because you need to move
the method elsewhere. In Vim you
would simply type in 250 and then
hit the “d” key twice (for delete
line). If you then want to paste it
somewhere else, simply move

there and hit “p”. No need for a
mouse or any highlighting
whatsoever.

How do you get around if you
can't use a mouse?

In GVim you are able to use a
mouse, though it's really not
necessary. In Vim you get around
using page up/page down and the
arrow keys (or hjkl where h=left,
j=down, k=up, and l=right).

What about syntax highlighting?

Vim and GVim are fully
customizable in a configuration
file, and allows for custom colors
and formatting for code according
to file extensions. It also offers a
very good syntax engine by default
that simply needs to be enabled.

What other useful features does
it offer?

It allows you to:
* Set a custom size (number of
spaces) for tab characters, which is
useful when coding python.
 Copy, paste, delete, and insert
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controls that allow for careful
formatting (dw = delete word,
dd=delete line, yw=copy word,
yy=copy line, p=paste, etc).

* Printing (with a sane printing
default)

* A tutorial that can be accessed
with the command 'vimtutor'

* Macros (easy creation and
execution).

Some basic commands:
hjkl — movement ( h=left, j=down,
k=up, and |=right) - this works only
outside of any mode. Inside a mode
you'll need to use the arrow keys.
y — copy (yy = copy line)
d - delete (dd = delete line)
w -word (used in conjunction with 'y
or d mainly)
1-o<command> - repeat the
command that number of times
(i.e. 250dd = delete 250 lines
starting at, and including, the line
currently selected)
:w — write (can be combined with g
to write and quit)
:e—open
:q — quit
Esc — exit any mode
i —insert mode (inserts before
current selection)
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a—add mode

r—replace mode

u-undo

ctrl+r - redo.

p — paste anything copied or
deleted in Vim/GVim

:hardcopy - the command to print
:%s/<regex>/<to replace>/ - allows
you to substitute anything you
search forin the first block with
what is in the second block. This
also accepts regular expressions.
:set <option> - allows you to set an
option for the running instance.
See my configuration file for some
examples of settings (which I set
for any instance).

ctrl+v - visual mode, allowing the
highlighting of multiple lines
inside visual mode:

| —insert before all highlighted
letters

X —delete all highlighted letters
*middle-mouse button (or shift +
insert) paste from external linux
clipboard after selecting the text
to paste.*

This is just a basic list of
commands | frequently use. The
line marked with asterisks is
actually a linux shortcut, but it's
very useful in Vim/GVim.

How do | use Vim/GVim?

To open a file, you can either
append the path after the
Vim/GVim command, or open it
using :e once it loads. Once you
have opened the file that you want
to edit, you can then hit “i” (the key
on the keyboard) to enter insert
mode. It will tell you what mode is
active (blank means there is
currently no mode being used) in
the bottom-left corner. For the
sake of this example, let us simply
write “Com3mand 6 Conque”. Once
you've entered the text, it's time to
fix it up. Move to the 3 using the
hjkl keys, and then hit the “x" key
to delete it. Head over to the 6 and
hit the “r"” key, and then enter the
ampersand (“&"). Once that's done,
you should have: “Command &
Conque”. Notice that the “r"is
missing! Move the cursor over the e
and you'll notice that you can't
move the cursor past the already
entered text. How do you enter the
r then? You can either hit the “i"
key for insert and move the cursor
using the arrow keys and then
enter it. Or, you could “append” the
text using the “a” key, which moves
the cursor to the space after the
selected letter. Then type “r" and
you're all set. If you want to save it,
do so with :w (and if you haven't
given it a path or name yet, you
must do so after the w). If you want

to just quit, use “:q” (in this case
you'll need to add an exclamation
point after the g to ignore the
changes made). After the “:q!", you
will find yourself back at your
desktop (From GVim) or in your
terminal if you used Vim.

A few things to remember:

The Vim shortcut keys that use
letters (u, ctrl+r, y, d, w, etc) all
require you to be in the “blank
mode” (i.e. without any editing
mode active). Otherwise, you'll just
type the letter. Get in the habit of
hitting escape after you've made a
change so that you don't start
typing in gibberish.

Using numbers to repeat
commands also works only outside
of a mode.

If, when pasting something, you
find that it spaces it all out oddly,
simply activate the past mode (:set
paste) and when you're done,
disable it with :set nopaste.

If you want to copy something,
and you find you copy the line
numbers too, simply shut them off
with :set nonumber, and back on
with :set number.
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If you have any questions, or
would like a follow up article with a
step-by-step example, please let
me know by emailing me at
[swest34@gmail.com. If you do
email me, please include C&C or
FCM in the subject line, so 1 don't
overlook it!

Files:
My .vimrc (I deleted some
functions that require external
software or are intended for use
with Mutt, so it may result in one
or two settings not working):
http://pastebin.com/wv260CJk
The colorscheme | use (see
screenshot):
http://dengmao.wordpress.com/20
07/01/22/vim-color-scheme-
wombat/
Screenshot (Full-size):
http://lswest.deviantart.com/art/S
creenshot-October-2011-
262486679

Lucas has learned all he knows from
repeatedly breaking his system, then
having no other option but to
discover how to fix it. You can email
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HOW-TO

Written by Greg Walters

Program In Python - Part 28

e are going to

explore even more

widgets provided by

tkinter. This time we
will look at menus, combo boxes,
spin boxes, separator bar, progress
bars and notebooks. Let's talk
about them one at a time.

You've seen menus in almost
every application that you have
ever used. Tkinter makes it VERY
easy for us to make menus. Combo
Boxes are similar to the list box
that we explored in the last widget
demo article, except the list “pops
down” instead of being visible at all
times. Spin box controls are great
for giving a fixed range of values
that can “scroll” up or down. For
example, if we want the user to be
able to choose from integers
between 1 and 100, we can easily
use a spin box. Progress bars are a
wonderful way to show that your
application hasn't locked up when
something takes a lot of time, like
reading records from a database. It
can show the percentage of
completion of a task. There are two
types of progress bars,
Determinate and Indeterminate.

You use a determinate progress bar
when you know just how many
items you are dealing with. If you
don't know the number of items or
the percentage of how done your
task is at any point, you would use
the Indeterminate version. We will
work with both. Finally a notebook
widget (or tabbed widget) is used
many times for things like
configuration screens. You can
logically group a series of widgets
on each tab.

So, let's get started. As usual,
we will create a base application
and build on to it with each extra
widget we add. Shown right is the
first part of our application. You've
seen most of this before.

Save all of this as
widgetdemo?2a.py. Remember we
will use this as the base to build the
full demo. Now we will start the
process of creating the menu. Here
are the steps we need to do. First,
we define a variable to hold the
menu instance. Like most any
widget we use, the format is...

OurVariable = Widget (parent,
options).
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import sys

from Tkinter import *

import ttk

# Shows how to create a menu
class WidgetDemo2:

def init (self,master = None):
self.DefineVars ()
f = self.BuildWidgets (master)
self.PlaceWidgets (f)

def DefineVars(self):
pass

And here is the bottom of our program. Again, you have seen this

before. Nothing new here.

if name__ == ' main__ ':
def Center (window):

# Get the width and height of the screen
sw = window.winfo_screenwidth ()

sh = window.winfo_screenheight ()

# Get the width and height of the window

rw = window.winfo_reqwidth()
rh = window.winfo_reqheight ()
Xxc = (sw-rw)/2
yc = (sh-rh)/2

print "{0}x{1l}".format (rw,rh)

window.geometry ("%dx%d+%d+%d"% (rw,rh,xc,yc))

window.deiconify ()

root = Tk()

root.title('More Widgets Demo')
demo = WidgetDemo2 (root)
root.after (13,Center, root)
root.mainloop ()
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HOWTO - PROGRAM IN PYTHON - PART 28

In this case, we are using the
Menu widget and we will assign it
to master as the parent. We do this
under the BuildWidgets routine.
Next we create another menu item,
this time calling it filemenu. We
add commands and separators as
needed. Finally we add it to the
menu bar and do it all over again
until we are done. In our example,
we'll have the menubar, a File
pulldown, an Edit pulldown and a
Help pulldown (top right). Let's get
started.

Next (middle right) we
concentrate on the File Menu.
There will be five elements. New,
Open, Save, a separator and Exit.
We'll use the .add_command
method to add the command. All
we really need to do is call the
method with the text (label =) and
then provide a callback function to
handle when the user clicks the
item. Finally we use the
menubar.add_cascade function to
attach the menu to the bar.

Notice that the Exit command
uses “root.quit” to end the
program. No call back needed for
that. Next we'll do the same thing
for the Edit and Help menus.

Notice the part in each of the

menu group definitions that says
“tearoff=0". If you were to change
the “=0" to “=1", the menu would
start with what looks like a dashed
line and if you dragit, it “tears off”
and creates its own window. While
this might be helpful sometime in
the future, we don't want that

def BuildWidgets(self,master):
frame = Frame(master)
#
# MENU STUFF
#
# Create the menu bar
self.menubar = Menu(master)

here.

Last but not least, we
need to place the menu.
We don't do a normal
placement with the .grid()
function. We simply add it

# Create the File Pull Down, and add it to the menu bar
filemenu = Menu(self.menubar, tearoff = 0)
filemenu.add command(label = "New", command = self.FileNew)
filemenu.add command(label
filemenu.add command(label
filemenu.add_separator()

"Open", comman
"Save", comman

self.FileOpen)
self.FileSave)

d =
d =

. . filemenu.add command(label = "Exit", command = root.quit)
by using the parent.config self.menubar.add cascade(label = "File", menu = filemenu)
function (bottom right).

All of this has gonein
the Buildwid tg ti # Create the Edit Pull Down
e bul Idgets routine. editmenu = Menu(self.menubar, tearoff = 0)
Now (next page, top editmenu.add command(label = "Cut", command = self.EditCut)
ﬁghU\Neneedlx)adda editmenu.add command(label = "Copy", command = self.EditCopy)
generic frame and set the editmenu.add command(label = "Pasfe"{ ?ommand = se}f.EdltPaste)
bef self.menubar.add cascade(label = "Edit", menu = editmenu)
return statement before # Create the Help Pull Down
we move on to the helpmenu = Menu(self.menubar, tearoff=0)
PlaceWidgets routine. helpmenu.add command(label = "About", command = self.HelpAbout)
self.menubar.add cascade(label = "Help", menu = helpmenu)
Finally (next page,
bottom right) we need to create all
the callbacks we defined earlier. .
For the demo, all we'll do is print # Now, display the menu
. . . master.config(menu = self.menubar)
something in the terminal used to #
launch the program. # End of Menu Stuff
#

That's it. Save and run the
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HOWTO - PROGRAM IN PYTHON - PART 28

program. Click on each of the menu
options (saving File|Exit for last).

Now (below) we'll deal with the
combo box. Save your file as
widgetdemo2b.py and we'll get
started. The imports, class
definition and the def __init__
routines are all the same, as is the
bottom part of the program. We'll
add two lines to the DefineVars
routine. Either comment out the
“pass” statement or erase it and
put in the following code. (I
included the definition line just for
clarity.)

First we define a label, which
we've done before. Next we define
the combo box. We use
“ttk.Combobox”, define the parent
and set the height to 19, the width
to 20 and the textvariable to
“self.cnbo1Val”. Remember that
we set textvariables in the last
widget demo, but just in case you
forgot...this is changed anytime the
value in the combo box is changed.
We defined it in DefineVars as a
StringVar object. Next we load the
values that we want the user to
choose from, again we defined that
in DefineVars. Finally we bind the
virtual event

self.fl = Frame(frame,
relief = SUNKEN,
borderwidth = 2,
width = 500,
height = 100
)

return frame

Next we (as we have done multiple times) deal with placing our
other widgets.

def PlaceWidgets(self,master):
frame = master
frame.grid(column = 0, row = 0)

self.fl.grid(column = O,
row = 0O,
sticky = 'nsew'

)

def DefineVars(self):

self.cmbolVal = StringVar()

self.clVals = ['None',6 'Option 1', 'Option 2', 'Option 3']

After our the self.F1 definition in BuildWidgets and before the “return frame” line insert the

following code.

# Combo Box
self.lblcb
self.cmbol

Label (self.fl, text = "Combo Box:
ttk.Combobox (self.fl,

height = "19",
width = 20,

textvariable = self.cmbolVal

)

self.cmbol['values'] = self.clvals
# Bind the virtual event to the callback

self.cmbol.bind ("<<ComboboxSelected>>",self.cmbotest)

def FileNew(self):
print "Menu - File New"

def FileOpen(self):
print "Menu - File Open"

def FileSave(self):
print "Menu - File Save"

def EditCut(self):
print "Menu - Edit Cut"

def EditCopy(self):
print "Menu - Edit Copy"

def EditPaste(self):
print "Menu - Edit Paste"

def HelpAbout (self):
print "Menu - Help About"
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<<ComboboxSelected>> to the
cmbotest routine that we will flesh
out in a minute.

Next let's place the combo box
and the label into our form (top
right).

Save everything and test it out.

Now save as widgetdemo2c.py
and we'll start with the separator
bar. This is SO super easy. While the
updated tkinter provides a
separator bar widget, I've never
been able to get it to work. Here's
an easy work around. We use a
frame with a height of 2. The only
changes to our program will be the
definition of the frame in
BuildWidgets after the combo box
bind statement and placing the
frame in the Place Widgets routine.
So, in BuildWidgets put in the
following lines (shown middle
right)...

Once again, you've seen all this
before. Save and test it. You'll
probably have to expand the
topmost window to see the
separator, but it will become much
more evident in the next demo.
Save as widgetdemo2d.py and we'll
add the spin control.

Under DefineVars, add the
following line...

self.spinval = StringVar()

By now, you know that this is so
we can get the value at any time
we want. Next, we'll add some
code to the Buildwidgets
routine...just before the “return
frame” line (bottom right).

Here we define a label and the
spin control. The spin control
definition is as follows:

ourwidget =

Spinbox (parent,low value,
high value, width,
textvariable, wrap)

The low value must be called as
“from_" since the word “from” is a
keyword and using that would
simply confuse everyting. The
values “from_" and “to” must be
defined as float values. In this case
we want it to have a low value of 1
and a high value of 10. Finally the
wrap option says that if the value is
(in our case) 10 and the user clicks
on the up arrow, we want it to wrap
around to the low value and keep
going. The same works for the low
value. If the user clicks the down

self.lblcb.grid(column
self.cmbol.grid(column
row = 2,
columnspan
pady = 2
)

0,
1,

row = 2)

=4’

And finally we put in the callback which simply prints what the user

selected into the terminal window.

def cmbotest(self,pl):
print self.cmbolVal.get ()

self.fsep = Frame(self.fl,
width = 140,
height = 2,
relief = RIDGE,

borderwidth = 2

)
And in PlaceWidgets put in this ...

self.fsep.grid(column = O,
row = 3,

columnspan = 8,
sticky = 'we',

padx = 3,
pady = 3
)

self.lblsc
self.spinl

Spinbox (self.f1,
from =
to = 10.0,
width = 3,

textvariable =

wrap=True

)

Label (self.fl, text = "Spin Control:")

1.0,

self.spinval,

fFull circle magazine #54 @ 10

contents ©




HOWTO - PROGRAM IN PYTHON - PART 28

arrow of the control and the value
is 1, it wraps to 10 and keeps going.
If you set “wrap=False”, the control
simply stops at whichever direction
the user is going.

Now we'll place the widgets in
PlaceWidgets (below).

Again, that's it. Save and play.
You'll really notice the separator
NOW.

Save as widgetdemoZ2e.py and
we'll do the progress bars.

Again, we need to define some
variables, so in the DefineVars
routine add the following code...

self.spinval2 =
self.btnStatus =
self.pbar2val =

StringVar()
False
StringVar()

It should be pretty obvious what
the two StringVar variables are.
We'll discuss the “self.btnStatus” in
a moment. For now, let's go and
define the widgets for this portion
in BuildWidgets (right).

Again this goes before the
“return frame” line. What we are
doing is setting up a frame for us
to put the widgets into. Then we
set up two labels as guides. Next
we define the first progress bar.
Here the only things that might be
strange are length, mode and
maximum. Length is the size in
pixels of our bar. Maximum is the
highest value that will be seen. In
this case it's 100 since we are
looking at percentage. Mode in this
case is 'indeterminate’. Remember,
we use this mode when we don't
know how far we've gottenin a
task so we just want to let the user
know that something is happening.

Next we add a button (you've
done this before), another label
another progress bar and another
spin control. The mode for the
second progress bar is
“determinate”. We will use the spin
control to set the “percentage” of
completion. Next add the following
lines (next page, top left) into the
PlaceWidgets routine.

self.lblsc.grid(column
self.spinl.grid(column

row

pady

)

4

N ~

#

# Progress Bar Stuff

#

self.frmPBar

self.

self.

self

self.

self.

self

self.

= Frame(self.f1,
relief = SUNKEN,
borderwidth = 2

)

1bl0 = Label (self.frmPBar,
text = "Progress Bars"
)

1bll = Label (self.frmPBar,
text = "Indeterminate",
anchor = 'e'
)

.pbar = ttk.Progressbar(self.frmPBar,
orient = HORIZONTAL,
length = 100,
mode = 'indeterminate',
maximum = 100
)

btnptest = Button(self.frmPBar,
text = "Start",
command = self.TestPBar
)

1bl2 = Label (self.frmPBar,
text = "Determinate"
)

.pbar2 = ttk.Progressbar(self.frmPBar,
orient = HORIZONTAL,
length = 100,
mode = 'determinate’',
variable = self.pbar2val
)

spin2 = Spinbox(self.frmPBar,

from = 1.0,
to = 100.0,
textvariable =
wrap = True,
width = 5,
command =

)

self.Spin2Do

self.spinval2,
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Lastly, we add two routines to
control our progress bars (botom
right).

The TestPBar routine controls
the indeterminate progress bar.
Basically, we are starting and
stopping an internal timer that is
built into the progress bar. The line
“self.pbar.start(10)” sets the timer
to 10 milliseconds. This makes the
bar move Ffairly quickly. Feel free to
play with this value up and down
on your own. The Spin2Do routine
simply sets the progress bar to

whatever value the spin control
has. We print it as well to the
terminal.

That's all the changes for this.
Save and play.

Now save as widgetdemo2f.py
and we'll deal with the tabbed
notebook widgets. In BuildWidgets
put the following code (below)
before the “return frame” line...

Let's look at what we did. First,
we define a frame for our

#

# NOTEBOOK

#

self.nframe = Frame(self.fl,

self.notebook = ttk.Notebook(self.nframe,

self.pl = Frame(self.notebook)
self.p2 = Frame(self.notebook)
self.notebook.add(self.pl, text
self.notebook.add(self.p2,text
self.lspl = Label(self.pl,

text = "This is a label on
page number 1",

padx = 3,

pady = 3

)

# Progress

Bar

self.frmPBar.grid(column = O,

self.1bl0.grid (column
self.lbll.grid(column

self.pbar2

row = 5,
columnspan = 8,
sticky = 'nsew',
padx = 3,
pady = 3
)
= 0, row = 0)
=0’
row = 1,
pady = 3
)
self.pbar.grid(column = 1, row = 1)
self.btnptest.grid(column = 3, row = 1)
self.lbl2.grid(column = O,
row = 2,
pady = 3
)
.grid(column = 1, row = 2)
.grid(column = 3, row = 2)

self.spin2

relief = SUNKEN,

borderwidth = 2,
width = 500,
height = 300

)

width = 490,
height = 290
)

'Page One')
'Page Two')

def TestPBar(self):
if self.btnStatus == False:

self.
self.
self.
else:
self.
self.
self.

btnptest.config(text="Stop")
btnStatus = True
pbar.start (10)

btnptest.config(text="Start")
btnStatus = False
pbar.stop ()

def Spin2Do(self):

v = self.
print v

spinval2.get ()

self.pbar2val.set (v)
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notebook widget. Now we define
the widget. All the options are
ones we've seen before. Next we
define two frames named self.p1
and self.p2. These act as our pages.
The next two lines
(self.notebook.add) attach the
frames to the notebook widget and
they get a tab attached to them.
We also set the text for the tabs.
Finally, we put a label on page
number one. We'll put one on page
number two when we place the
controls just for fun.

In the PlaceWidgets routine put
the following code (below).

The only thing that might
possibly be strange is the label on
page two. We combine the
definition and placement in the
grid with the same command. We
did that when we did our first
widget demo app.

That's it. Save and play.
As always the full code for the

full application is up on pastebin at
http://pastebin.com/gSPkSNU1.

Enjoy. Next time we'll deal with
some more database stuff.

self.nframe.grid(column =
row = 6,
columnsp
rowspan
sticky =
)
self.notebook.grid (column
row =
column
sticky
)
self.lspl.grid(column = 0
self.lsp2 = Label(self.p2
text =
padx =
pady =
) .grid(

0,

an = 8,
:7,
'nsew’

= 0,

o,

span = 11,
= 'nsew’

;row = 0)

column = O,
row = 1

)
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Below Zero is a Co-located Server Hosting specialist in the UK.

Uniquely we only provide rack space
and bandwidth. This makes our service
more reliable, more flexible, more
focused and more competitively priced.
We concentrate solely on the hosting of
Co-located Servers and their associated
systems, within Scotland's Data
Centres.

At the heart of our networking
infrastructure is state-of-the-art BGP4
routing that offers optimal data
delivery and automatic multihomed
failover between our outstanding
providers. Customers may rest assured
that we only use the highest quality of
bandwidth; our policy is to pay more for the best of breed providers
and because we buy in bulk this doesn't impact our extremely
competitive pricing.

At Below Zero we help you to achieve Zero Downtime.

www.zerodowntime.co.uk
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HOW-TO

Written by Hans Vandeveire

“ freeMind

NOTE: LibreOFffice will return
next issue.

reeMind is a mindmap

application: a graphic way

of structuring thoughts,

opinions, ideas, objects, or
any other thing you need to have
visualized in a nice way.

A mindmap can be used for
structuring any information in any
domain: it's a way to organize
details, input or records of any
kind. Examples could be: a
shopping or to-do list; a note-
taking tool in classrooms; a
presentation tool for board
meetings... in fact: the possibilities
with mindmap applications are
limitless.

Amongst all other mindmap
software, FreeMind is a free and
high quality program and
productivity tool, made in Java, and
licensed under GNU 2 GPL V2+,
meaning it's free to use the
program for whatever purpose you
want. Asitis developedin Java, it

is available on any computer

platform such as Linux, Apple/Mac,

or Microsoft environments.

FreeMind is the ideal tool for,

let's say, anything you need to
organize in your daily life, at

school, or at work . Planning and
organizing parties, weddings, or
any event; projects like moving to

another place, building a new
house, or reconstructing the
kitchen; it's even an interesting
way to collect recipes, phone

numbers, or as a catalog of your
stamp collection. Teachers can use
it to prepare and present lessons;
students can use it as an exam
preparing program; and even for
writing essays it can be very useful.
At work | use FreeMind daily fFor
preparing and presenting
meetings, brainstorming, and as a
to-do list. By the way: this
FreeMind article is mainly written
in FreeMind and exported to
LibreOffice for editing and fine
tuning afterwards.
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Installing the
application

Installing FreeMind is easy: just
grab it from the repository by
searching for it in KpackageKit
(KDE) or in the Ubuntu Software
Center (Gnome): all necessary files
will be installed in a moment. The
FreeMind startup icon will be
shown in the office-category:
clicking on it will launch the
application in seconds.

Exploring the
application

As soon as you have the
application on your desk, you'll
discover:
 the menu: you'll find common
'file', 'edit’, and 'view' menu-items
and specific application-items (in
most cases a keyboard shortcut is
also available)

* a horizontal toolbar: you'll find
most used application commands
as a button or dropdownlist

* tabs: you can open different
mindmaps and switch easily from
one to another

contents ©



HOWTO - FREEMIND

« the main window: your working
place: start thinking, and write
what you think

* a secondary vertical toolbar: you
can add icons to nodes, here you
can pick them

 a note window (at the bottom):
you can add text (html) to a
selected node

Using the application

The first time you open
FreeMind, a brand new empty
mindmap is ready for your brilliant
ideas: click on 'New Mindmap', and
change the title to your subject
(e.g.'FCM article about FreeMind').

Press the <insert> key for a
first-level item (e.g. 'introduction’),
and press <enter> for the second
first-level item (e.g. 'installing the
application'). Create new child
nodes and sibling nodes as fresh

ideas are bubbling up in your head.

You can use shortcut key
combinations: use arrow keys to
navigate from one node to
another; and <insert>, <enter>,
<escape>, and <delete> keys for
basic editing; you use <F2> for a
selected node to edit the text of
the node.

Of course, you can use the
mouse to select a node and click on
the menu items or buttons to
create your entire mindmap.
Clicking on a node with child nodes
will open or close the nodes (and
attached nodes), and you can shift
the complete mindmap to any
place by clicking and dragging
outside a node.

For practical reasons, nodes are
usually rather short, although it's
possible to create long nodes. It's
possible to attach a note for a
selected node (bottom window).
Use the built-in simple html-editor
for good looking text formatting or
even tables. Advanced users can
try the html code view (second tab
at the bottom of the note window).
A note can be the text of a chapter
(node), or extra information for an
item (node).

Pressing the <ALT>+<I>
combination opens the icon
catalog: you can add icons to a
selected node for better
understanding (the icon can
explain a priority level, a to-do
result, a project milestone, ...);
icons are also available by clicking
on them on the secondary vertical
toolbar on the left.

<5+ installing the application

<+ exploring the application =

| @ mouse gesture |
. | @ short key (lkeyboard) |
{ glludcf |

<~/ using the application §

N
‘I"\)I’“l ites |
'\{ @icons |

article about FreeMmd \_’\

bV lay-out |

(@ links

\i # editing plam—mcr‘ut of the node

@ special functions §

~——— |

(

Rl

.'f i
[ java
f

And another function is making
this software a high quality
product: nodes can be marked as
hyperlinks (Insert > Hyperlink) to
open a file, website, or e-mail
editor, or to navigate to another
part of the mindmap. You can even
link pictures to a node, and couple
nodes with a graphic link (check
the items in the Insert menu).

If you want to change the order
of the nodes, you can easily drag
and drop selected nodes to
another place. The shade of the
node you're dragging the node to
tells you whether it will be a child
or a sibling node.

Even some special functions are
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available th rough the Tools menu.
Time scheduled nodes can be made
for reminding the userin a project
mindmap. Revisions can be colored
yellow.

As your mindmap is getting
bigger, you might want to use the
filter (horizontal toolbar, 4th icon
from left) to find a node or text
(press the Filter icon and edit the
query you need).

Layout

The layout of your mindmap is
still basic. FreeMind has some
fancy features to embellish your
creation. Clicking on the menu item
Format > Automatic layout
transforms the simple mindmap
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into an awesome presentation of
your ideas.

But more is possible: every node
(single or multiple selected) can be
edited. You can change the font,
size, color, and shape of the node
text, and also the edges of the
node can be edited. Make nodes
blink to get the attention of your
public, or draw a cloud around a
group of nodes to emphasize the
priority of the item (Insert > Cloud).
The use of styles is possible by
right clicking on a node (Physical
Style), or by the menu item Format
> Physical Style.

Exporting

If content and layout are ready,
you might want to export your
mindmap to another format (File >
Export):
 export a branch to a new map
* export to html-file
* export to flash html file
 export to xhtml file (clickable map
image or javascript version)

« export to OpenOffice/
LibreOffice text document (the
text you're reading was originally
made in FreeMind, and then
exported to a LibreOffice .odt
format)

 export to JPG or PNG image file
(shown right).

Presenting or using your mindmap
can be done in any way, according
to your needs.

Peferences

By changing the preferences,
the user can change default
settings such as automatic layout,
language, environment, behavior,
keystrokes, and more (Tools >
Preferences). This way, FreeMind
becomes a very handy tool with a
personal touch.

Documentation

More information is accessible
through the Help menu:
* a built-in mindmap as a help
function is always available,
showing all possibilities and
functionalities of the application
* a key-mapping quick guide is also
available in PDF (highly
recommended if you don't change
the default settings)
* a wiki with complete project
information, documentation, and
FAQ page can be found on the
FreeMind wiki.

Don't fForget to visit the 'Thank

you for the
music page' to
express your
thanks and _
satisfaction with |
FreeMind... this
is the only way
the contributors
are being paid!

My opinion

Computers
and software are
made to make
our lives and
work easier and
more
comfortable.
FreeMind is one

 pictures

\_&V what's FreeMind |

good example of
it: it is easy to install, easy to learn
how to use it, very efficientin a
wide range of situations, and with
interesting exporting
functionalities. Some minor points
could be (but please, ignore them):
a poor picture editing functionality
and no kde integration of the
software layout. It's a single user
program, so collaboration with
multiple users at the same time is
not possible (yet?); but it is easy to
spread the file by mail or by web -
thanks to the many ways of
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exporting the file.

Install and try it right away;
write a review about your favourite
(k)ubuntu software with FreeMind
and send it to Full Circle.

(2=
Hans has been using Ubuntu since
Dapper Drake, works as a system
tester, and is interested in social
media, IT, folk music, and Albania.
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Written by Allan J. Smithie

Backup Strategy - Part 2

et's rewind. In part one, we
posited that the safest
data storage plan goes
something like this:
* local machine disk: original or
master copy
* network storage disk: common or
shared copy
« off-line storage, which these days
means remote cloud storage, or
on-line back-up.

This isn't simply jumping on the
bandwagon of 'Clouds with
everything.' A true off-site backup
uses someone else's data-center,
which is itself backed up. This
offers maximum peace of mind
that your precious, ephemeral data
can't be lost, even if your original
goes up in flames, down in floods,
or gets exterminated by a Blue
Screen of Death.

We all know the issues with the
traditional backup solution; either
it's not done regularly, or
somebody sends the wrong
generation of tapes to the off-site
safe. Or your data DVD sits on top
of the book-case for six months
when you should have taken it to

Grandma's house. 'The Cloud' may
be flavor-of-the-year right now, but
that doesn't mean you should
ignore, we should say, the
multitude of Clouds available.
Cloud back-up has become an
industry in and of
itself. Your only
real difficulty

is choosing
which
Cloud and
which
provider
meets
your
needs.
Everyone
seems to
be offering
Cloud
storage, that's
not the same as a
Cloud back-up service.

Perhaps we should begin by

running down a check-list to help
make the decision.

Cost

It's where | always start. Is there

fFull circle magazine #54 @ 17

an up-front fee? What's the
ongoing monthly or annual fee?

Software

All the mature services offer
dedicated software clients to
manage the upload and download
process. All claim to be cross
platform, so long as that means
Windows and Mac. Many now have
a Linux client available.

How much storage do | get for
my money? What service level -
that's performance and up-
time availability —
does that buy me?
How big is the
jump between
price and
storage

| like the idea of browser-based
upload and download, also called

bands? “NOT having to use a proprietary
program to access the service.”

ClOUfj This is where Ubuntu One scores,

backupisa  eyen though it's basic Cloud

-CFOWded: storage rather than a fully-fledged

Immature cloud backup at present.

market right
now, with
Sroviders Ease of Use

clamoring for our
business. For the

average householder,
there are introductory offers of
basic packages at zero cost, all
luring us in with the prospect of
the up-sell later. | like free storage
space. It seems everyone's
providing it, so we have to refine
our criteria.

We also want ease of use,
whereby;
* setup and installation is simple,
and completed within a few steps
of downloading the software.
 on-line backup can runin the
background while we get on with
our normal activities, without
hogging all our bandwidth; a user-
setting for the upload speed is
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essential.

e includes and excludes are easily
defined for each back-up set, to the
lowest granular level of file name
or file type, using wild-cards.

* the scheduler should allow
unattended back-ups to a
frequency and time-of-day set by
you, preferably down to the
minute.

* data can be restored easily and
immediately, with some notion of
versioning of back-up sets.

* we have easy, centralized
management of all our backups
sets with sufficient meta-data to
distinguish sets from each other.

Encryption

These days we should take data
security very seriously. Thank you,
Sony and the DoD. A true back-up
of all your important stuff is going
to include your personal stuff,
banking, and correspondence.
Nobody wants to suffer identity
theft.

As far as the Cloud is concerned,
there are several ways of doing
this, the best being to implement a
solid version of 128-bit encryption,
minimum, at the client end, before
it leaves your machine to travel

over the wire. Preferably this
should include blind signing so that
nobody at the provider has your
key which could compromise your
data, either through an inside job
or as the victim of an external hack.
You have to be your own
policeman.

Performance

We absolutely need speed and
reliability. The platform at the
providers' facility also needs to be
scalable; it shouldn't slow down or
fail every time the US East Coast
wakes up and goes on-line en mass
at 8am EST. The theory also
needs to work in
practice, as
Amazon S3
discovered
earlier this
year.

The
service
also
needs to
maintain
our data
mirrored
for
resilience
and fail-over,
as protection

against data loss due to sabotage,
fire, theft, flood, virus, or other
disasters. Put another way, your
Cloud service shouldn't be keeping

boxes of tapes at Grandma's house.

This is what we in business call a
compliance test.

Convenience

Now things get interesting,
separating men from boys, sheep
from goats, and mixed-metaphors
from clichés. It may be that the
deciding x-factor is one of these;

* file-sharing capabilities; being
able to define shares, 'rooms’,
'‘peeks', or public links at the
granular File level,
with some tiered
security
according to
permissions
that you
alone are
able to set
from your
management
console.

* remote web
access to data,
at anytime.
Ideally it's that
browser-based
client that allows you
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to securely access your data
(perhaps without all the
capabilities as the dedicated client)
from any machine.

e true 24-by-7-y-365 data
availability. See Performance.

* status reporting for verification
and audits. We need to have
confidence demonstrated by
proper management information.

Very little of this is new; in fact,
most conventional client-side
backup applications and web-
hosting services have all these
covered; now is the time to put the
two together in the Cloud. With
these considerations in mind, you
can now look at the various
services on offer, and judge for
yourself how they stack up.

|k ="

Allan J. Smithie is a journalist and
commentator based in Dubai. His
blog, 'No Expert,'is at:
http://allanjsmithie.wordpress.com
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Written by Jesse Avilés

Ubuntu For Business & Education - Pt.3

uick, what is 20x3+5? If

you can read this, and

answer the previous

question, you can thank a
teacher. Did you use a calculator, or
a specific set of eyeglasses, to
solve the equation? The teacher
taught you the mental process to
it. From these basic building blocks,
you learn increasingly complex
concepts. It is not until you get to a
university that you are limited to a
certain set of tools to complete the
task at hand, and sometimes due to
a physical need (think of a
microscope). Let’s look at two
other equations:

Ly

3x20 =

e

+7

The results for both equations
are different. There is a mnemonic,
PEMDAS, that reminds us that the
order to solve an equation is:

parenthesis, exponentials,
multiplication, division, addition
and subtraction. When | started
college, my parents bought me an
HP-42S because | needed a
graphics calculator. It was an
excellent calculator, but it did not
work for me at first. The calculator
was based on the Reverse Polish
Notation (RPN)
(http://en.wikipedia.org/wiki/Rever
se Polish notation), which I did not
know at the time. It took me about
an hour to get the hang of it. RPN
is not the usual way we are taught
in school. In RPN, the operators
(mathematical operation) come
after the all the operands
(numbers) it will be applied to.
Thus, the equations in RPN will be:
155+7+203 x
155+203x7+

In order to solve the equations,
in the traditional or RPN way, you
have to know how it is done. The
tool that you use, traditional or
RPN calculator, will give the same
results. The important part is the
mental process. Think for a minute
how different things will be if we
were only taught to punch

numbers in a calculator, a specific
calculator at that, and then have
the calculator die on us. In the US,
those of us that hold a bachelor's
degree have to go through around
16 years of school. We are taught
to use tools, yes, but mostly to
think, to push ourselves to resolve
problems in a creative way - so that
the people around us and the next
generation can do better. Back in
the Greek empire, grown men were
taught algebra. What they learned
we now call pre-algebra, and teach
it to seventh graders!

Once you have learned, you
start using tools to improve your
work. Scribes learned how to read,
write, and do math. They were also
employed to copy old texts. This
copying was done by hand which
was slow and painful. When
Gutenberg introduced the printing
press, the process of creating
books changed forever. Today, we
have word processors that make
the process easier. And still,
learning to write by hand is a
required skill. Tools exist just to
improve our basic skills.
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As a kid, papers | had to turn
over to the teachers were always
done by hand. I would really like
that this be a requisite up to sixth
grade because it ingrains the
syntax and grammar rules in our
kids. My daughter has used
computers to do school-work since
fourth grade. One time, | looked at
the screen and told her that
several words were misspelled. Her
answer was that | should not worry
because the computer will fix them
for her. | was astonished! She did
not care about proper spelling
because a “tool” could do it for her.
Here was a prime example that
learning was changing and not for
the better.

Where does Ubuntu fallin all
this? Ubuntu, like Windows,
Android, OSX, iOS, and many
others, is an environment for tools.
They all offer their capabilities for
those who use them. What Ubuntu
offers that really differsin a
meaningful way to school
administrators is cost savings. | had
a computer for nine years. That
computer started as a Windows XP
machine, and died with Ubuntu in
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it. That is nine years of not
acquiring new hardware, and not
paying (a lot) for software. The
saved money can be used for
capital improvements to the school
- which endure for a long time, and
benefit generations of students.

For students, it offers tools that
they can use at home without a
huge cost and, in many instances,
for free. It also offers a deterrent
to (some) software piracy. It always
blows my mind when a kid pirates
1GB of Adobe CS when they could
freely download Kompozer,
Scribus, Inkscape, and GIMP, and
get the same results (meanwhile
their parents do nothing about it).
Getting used to a different set of
tools also forces the student to
learn the basics to be able to
transport that knowledge to
different tools.

Take, for example, web pages.
Some schools offer courses in web
page creation. These schools buy
Dreamwaver, and go through the
templates. They spend little time
explaining what HTML and CSS are,
and how they are integrated. You
can always learn to use
Dreamweaver or Expression Web,
but, no matter what your tool is,

the basics are the same. In Ubuntu,
you may use Bluefish or Kompozer.
With Bluefish you have to know
your basics because there is no
WYSIWYG interface. Kompozer has
such an interface, and, once you
know your basics, the WYSIWYG
interface will help you a lot but not
all the time.

Another tool to emphasize
proper skills is Latex. Latex is all
about writing and producing
written documents. Latex
philosophy is that the writer should
worry about writing and the
software worries about the
presentation. Go to the
repositories and try Lyx. You will
notice that it is not your regular
word processor. You cannot add
meaningless space to separate
words or paragraphs, or set
capricious fonts throughout the
document. As it says in their web
page: “What you see, is what you
mean.” You have to concentrate in
just writing. Sections, paragraphs,
syntax, lists, definitions, emphasis,
and flow are your realm;
presentation is Latex. A great tool
for aspiring writers to really
concentrate on their writing.

You will notice that | have not

mentioned Edubuntu. That is
because | have had mixed success
with it. Edubuntu offers a broad
set of tools to students. It offers
pre-school to high school (and
some more) software. The basic
Edubuntu distribution is good as a
starting point for people with
mixed needs (think grades). If the
population you will serve is
uniform, you can download Ubuntu
and just install the target school
grades you need. Another thing to
consider is that you may not want
the software offered by Edubuntu,
and a plain Ubuntu install will
suffice.

One of Edubuntu strongest
points is the use of iTALC
(http://italc.sourceforge.net/) and
LTSP (http://ltsp.org/). iTALC
provides classroom management.
With it, the teacher can see all the
computers in the room, and
provide remote help and tutorials.
LTSP lets schools use less powerful
computer hardware for the
students, and moves the OS and
computational needs to a powerful
server.

School administrators flock to
Windows because that is what they
are used to, because it is agency
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policy, because it is in their
comfort zone. As personal trainers
everywhere say: “You have to move
out of your comfort zone to get
results.” Andalucia, think of it as a
state in Spain, in 2003, established
a law to use free software. To that
effect, in 2003, a Linux distribution
was created to use in schools. The
distribution is called
Guadalinexedu
(http://www.quadalinexedu.org/),
a mixture of Ubuntu and
Guadalinex
(http://www.quadalinex.org/). It is
in use in over 2,500 centers and
500,000 computers. For those of
you that can read Spanish, check
Andalucia's Board free software
declaration at
http://www.juntadeandalucia.es/or
ganismos/economiainnovacionycie
ncia/temas/tic-
telecomunicaciones/software-
libre.html.

For those who install Ed/Ubuntu
in their schools, be aware of the
use of codecs. As | said previously,
Ubuntu does not provides the
licenses to create mp3, mp4, wma,
wmv, mpg, and so many others.
You will have to obtain those
licenses if you want to create
content in those fFormats. That will
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not limit your capabilities. You can
always encode to FLAC (lossless
compressed audio), ogg Vorbis
(lossy compressed audio), and ogg
Theora (video), and, pretty soon, to
Google's VP8/WebM.

| have had mixed success in my
Ubuntu installations. Ten (a puny
number, | know) of the
installations, | have followed
through the years. Some have had
Ubuntu since 8.04. Just one
installed a pirated Windows
version. That one is in a church, and
used for the youth in the
community. Shame on them! Two
have Edubuntu, used by kids in
elementary and middle school. All
say that they will not change their
Ubuntu computers. The only bad
thing is that they will not buy a new
computer pre-installed with
Ubuntu. | stay hopeful.

|k ="

Jesse is an industrial microbiologist
from the environmental field who
now works for the government.
Along the way loving FOSS and ways
to help people with it.

(©)) ubuntu

The Ubuntu Podcast covers all the
latest news and issues facing
Ubuntu Linux users and Free
Software fans in general. The
show appeals to the newest user
and the oldest coder. Our
discussions cover the
development of Ubuntu but aren’t
overly technical. We are lucky
enough to have some great guests
on the show, telling us first hand
about the latest exciting
developments they are working
on, in a way that we can all
understand! We also talk about
the Ubuntu community and what it
gets up to.

The show is presented by
members of the UK’s Ubuntu Linux
community. Because it is covered
by the Ubuntu Code of Conduct it
is suitable for all.

The show is broadcast live every
fortnight on a Tuesday evening
(British time) and is available for
download the following day.

podcast.ubuntu-uk.org
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..ServerCircIe

Server Circle is a new question and answer site run by
techies.

Users with any level of experience can ask technical
questions for free about anything server related, and
receive answers from trusted experts, who are rated by
the community.

With time you can earn
reputation points, and even
financial rewards, by
contributing your answers to
questions from other people.

http://www.servercircle.com

Recent | Fopular | Unanswered | Rewards

&8

17 views
0 repliss

Which packages can | safely uninstall on Ubuntu Server ?

ANSWer now

by Squeeze (445 points) in Ubuntu Linux - 0 votes

How to access a Intel Express 535T Switch Hub

ANSWer now

34 views
4 replies
by GoldAlchemist (50 poirts) in Metworking - 1 votes

How to use wired desktop for server to wireless notebook

NOTE: Server Circle is not affiliated with, nor endorsed by, Full Circle magazine.
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Written by Artemy Vysotsky

Apt-Cacher-NG

've only ever had two
computers running Ubuntuy, |
somehow tolerated the need
to download the same
packages twice. But, now I'm
planning to add one or two more.
And it seems such a waste of time
and traffic. So, | started looking for
a solution, and found the apt-
cacher program. | have installed it
and was rather satisfied with the
results... till  upgraded my server
machine to Ubuntu 11.04. While
apt-cacher was enabled, all my
updates were returning errors. So, |
started again looking for a
solution, and have encountered
another deb-package proxy - apt-
cacher-ng. | have replaced my old
package proxy with the new one,
and now updates on my second
machine take no time at all.

So, what is apt-cacher-ng, and
why do you need it? This is the
program that caches all your
downloaded .deb files, and shares
them among all your computers in
the LAN - eliminating the need to
download the same package again
and again.

Below, | will describe the step-
by-step procedure | followed to
install and configure it in my
network.

As a source for the procedure,
the tips from the following
discussion were used:
http://ubuntuforums.org/showthre

ad.php?t=1327179.

| had apt-cacher already
installed, so:
* | copied all my deb-files stored in
the apt-cacher cache (folder -
/var/cache/apt-cacher/packages) to
a temp folder on my home
partition.
* removed apt-cacher completely.

If you do not have apt-cacher
installed, you'll just skip these two
steps as not relevant.

Next, install the apt-cacher-ng
package on your server using your
preferred package install method.

Start the program. In terminal
mode, run the command:

sudo /etc/init.d/apt-cacher-
ng start
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Configure the package routines
on your other computers to use
apt-cacher-ng as a proxy. There are
several approaches to do this. The
one that worked for me, and seems
to be the simplest, uses the
/etc/apt/apt.conf configuration
file. Eit this file, or create it if it
does not exist. You can use the
following command in terminal
mode:

sudo nano /etc/apt/apt.conf

You can replace nano with the
name of your Favorite text editor,
for example, gedit. Add the
following line to the file:

Acquire::http { Proxy
"http://192.168.2.11:3142";
}i

Replace the 192.168.2.11 with
the IP Address of your server
computer. The same action should
be done on each Ubuntu computer
in your network.

Next, run the “update” using
your package management
software. For example, in terminal

22

mode, you can use the following
command

sudo apt-get update

This ensures that the apt-
cacher-ng builds the package
index. Now it will know which
packages it should store in the
cache.

Actually, at this point the proxy
is ready to work, but the cacheis
empty, and it will take time to
populate it with packages. But wait
— | have already stored some deb-
files just for this moment. So now
is a good time to make use of all
the deb-files | have saved:

* Go to the /var/cache/apt-cacher-
ng folder, and create _import sub-
folder.

* Copy all deb-files stored in your
temp home folder to
/var/cache/apt-cacher-ng/_import
(and delete the temp folder and its
contents).

* | also have some packages in the
local apt caches on both my
Ubuntu computers. So | also copied
all deb-files from
/var/cache/apt/archives on both
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my computers to the
/var/cache/apt-cacher-ng/_import
folder on my server computer.

Now it is time to actually run
the import process. The program is
controlled through a web page. So
open

http://<IP_address_of_ server>
:3142

and you will get the page
explaining the usage of apt-cacher-
ng, and with the small link
“Statistics report and configuration
page” in the “Related links”
section. Clicking on the link will
bring you to:

http://<IP_address_of_ server>
:3142/acng-report.html

Scroll down and click the “Start
Import” button. This will open
another page detailing the package
import process as it goes. It will
take some time depending on the
number of packages you want to
import.

From now on there will be no
need to download the same packet
several times for different
computers. For further reading,
you can open the documentation

installed with apt-cacher-ng and
available through
http://localhost/doc/apt-cacher-
ng/html/index.html on your server
computer. Note that you will need
to change the default
configuration of the apache2
server to make the server
documentation available on all
your LAN computers. To do so:
 open the /etc/apache2/sites-
enabled/000-default file for
editing as root. For example use
the following command

sudo nano /etc/apache2/sites-
enabled/000-default

Replace nano with your favorite
text editor if you wish.

* Find the section that starts with
Alias /doc/

Modify the entry 'Allow from' to
give access to all computers in your
LAN.

For example:
Allow from
10.1.0.0/255.255.0.0

will give access to the
documentation directory through
your apache2 web-server from all
IPs in the range 10.1.x.y

| hope this guide will help you
set your home network for more
efficient use.
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Book Review

Barefoot into Cyberspace by Becky Hogge
Written by Robin Catling

Can we keep the Internet an open, democratic and free
tool for the betterment of mankind? Barefoot into
Cyberspace tackles this question. Written by a recent
guest of ours on the Full Circle Podcast, Becky Hogge
is a journalist and former director of the Open Rights
Group. In it, Hogge seeks out the radical hackers
opposing the old institutions gathering to control the
Internet.

Documenting a personal journey into 'hack-tivism,' Hogge begins
and ends at the Chaos Computer Club's annual conferences in 2009
and 2010, in the company of four recurring guides; Stewart Brand,
Cory Doctorow (author, blogger and copyleft campaigner), Phil
Booth of No2ID and Rop Gonggrijp, co-founder of the Dutch ISP
XS4ALL. Along the way, Hogge interviews Wikileaks' Julian Assange
and Global Voices founder Ethan Zuckerman.

Touching the issues of copyright versus copyleft, personal privacy,
the surveillance society, freedom of information, censorship and the
commercial takeover of the Internet, this is a study of individualists
against institutions, questioning how we might oppose the vested
interests of moneyed entities with largely amoral agendas.

You also get the slightly anti-climactic story of how Hogge
declined to join Wiki-leaks, albeit in recognition of the commitment it
takes to be that kind of activist. This running series of encounters
highlights the one weakness of a book that never quite ties together
all its themes into one coherent narrative, but you could argue that's
how life is, amplified by the disjointing effect of technology and the

rapid pace of change.
CONT ON PACGE 26...
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Written by Ronnie Tucker

Write For Full' Circle Magazine

Guidelines

he single rule for an
article is that it must
somehow be linked to
Ubuntu or one of the
many derivatives of Ubuntu
(Kubuntu, Xubuntu, Lubuntu, etc).

Write your article in whichever
software you choose. | would
recommend OpenOffice, but
PLEASE SPELL AND GRAMMAR
CHECK IT!

Writing

In your article, please indicate
where you would like a particular
image to be placed. Please do not
embed images into your Open
Office document.

Images

Images should be JPG with low
compression.

Regarding image sizes: if in
doubt, send a full size screengrab
and we will crop the image.

If you are writing a review,
please follow the guidelines shown
here.

For a more detailed list of the
style rules and common pitfalls
please refer to:
https://wiki.ubuntu.com/UbuntuMa

gazine/Style - in short: US spelling,
no (33t speak and no smilies.

When you are ready to submit
your article please email it to:
articles@fullcirclemagazine.org

If you can't write articles, but
hang out in Ubuntu Forums, send
us interesting forum threads that
we could print.

Non-English Writers

If your native language is not
English, don't worry. Write your
article, and one of the
proofreaders will read it for you
and correct any grammatical or
spelling errors. Not only are you
helping the magazine and the
community, but we'll help you with
your English!
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REVIEWS

Games/Applications
When reviewing games/applications please state clearly:

* title of the game

* who makes the game

e isit free, or a paid download?

« where to get it from (give download/homepage URL)
e isit Linux native, or did you use Wine?

 your marks out of five

» a summary with positive and negative points

Hardware
When reviewing hardware please state clearly:

* make and model of the hardware

» what category would you put this hardware into?

any glitches that you may have had while using the hardware?
* easy to get the hardware working in Linux?

« did you have to use Windows drivers?

« marks out of five

» a summary with positive and negative points

You don't need to be an expert to write an
article - write about the games, applications
and hardware that you use every day.
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o, we've got our CCTV to
run as a monitor to see
what’'s going on outside;
we can record said events;
and we can even detect motion to
trigger a recording. But, how do we
deal with false positives? Read on.

With ‘Modect’ (motion
detection) enabled as your
‘Function’ in ZoneMinder, click the
‘0’ (zero) under ‘Zones’, and you'll
see a new window:

@ localhost/zm/index.php?view=zones&mid=2

Zones Close

Name | Type | Area (px/%)

This is where we will define
zones to include, or exclude, from
the motion detection. Click ‘Add
New Zone' to get another new

B LINUX'LAB
Written by Ronnie Tucker

window (shown below).

The zone window will let you
assign a name to your zone; then,
in the drop down menus, you can

tell ZoneMinder what you want this

zone to be. Active is just that, the
zone is activated and ready for
movement within it. Inclusive,
Exclusive, and the other types, are
best explained in the ZoneMinder
wiki at:
http://www.zoneminder.com/wiki/i

ndex.php/Documentation#Definin
g_Zones. For example, you could
create a zone around your car
which would be active while

ZoneMinder CCTV - Part 3

another zone could be inclusive.
This means that, when your car
zone becomes active, it would
trigger your inclusive zone(s) to
record catching the thief leaving
the scene of the crime. To edit the
first zone (the first one is already
created in the window and is
waiting for you to edit it), you
simply drag the corners of the (in
this case) green box to surround
the area. You can click the small '+
icon beside a point to add another
point after it - to help in creating
complex zones. Next, choose a
preset for the zone, the preset will
depend upon your hardware and

Monitor Monitor-2 - Zone New

Name

Type

Preset [Choose Preset v |

Uniits

Alarm Colour [Red/Green/Blue) oo

Alarm Check Method

Min/Max Pixel Threshold (0-255)| [ | ]

Filter Width/Height (pixels) 1 =T

Zone Area

Min/Max Alarmed Area i ——

Min/Max Filtered Area 1 I

:::x Z::::rea I:l I:l Point X ¥ Action || Point X ¥ Action
Overload Frame Ignore Count || ; i ?
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how precise you want to be in the
monitoring.

Jromium

hp?view=zone&mid=2&zid=6

o
@
i
-3
-

m
5
&

i
@
@
@

Point X Y
- | 2
+- 4

Action || Point X ¥ Action
| -
+-

TN O0=E

0RO

So, I've created an active zone
which excludes my left hand.

Zones Close

Name Type Area (po/%)

right Active 40755/ 53.07 |

IF I move my left hand to my
right side, or move my right arm,
then an alarm will be activated, but
if | keep my left hand on the track
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pad - even while moving it - then no
alarm will trigger.

Monitor-2

Seale:

State: Idie - 14.97 fps

EIEIIIIDEIEIEIEI

Mode: Live Zoom: 1.0x

Id Name Time Secs Frames Score

| knew it! I've always has my
suspicions that my right hand was
trying to steal my laptop!

Like we did last time, you click
the number below events to see
your list of events, and click to play
back the recorded alarms.

You can get really complex zone

Manitor-2

Scale: (AT ¥ ]
EEY, 3]

State: Idle - 14.92 fps

DEIIIIEIEIEIEIEI

Mode: Live Zoom: 1.0x

Time Secs Frames Scure
2011-09-20 20:38:18 3.42 51130
2011-09 20 20 38 08 199

Id Name

patterns in ZoneMlnder 36) take
the time to play with them!

Next month we’ll have an article
from John D showing you how to
set up VOIP at home.

(2=
Ronnie is the founder and editor of
Full Circle, and a self-taught artist
who's website is at:
http://ronnietucker.co.uk
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If you want a grand 60 Minutes-style expose of dark deeds,
conspiracy theory and armed insurrection - this won't be the book for
you. It's altogether gentler than that. Enjoy the retrospective of the
“hacker” movement and origins of the 1970's counter-culture;
communes seeking freedom, peace and love, through the early
examples of Brand, Stallman, Lessig and the pioneers of the hacker
movement, which, remember, is about more than just getting free
stuff.

Rop Gonggrijp gets all the best lines - well, they are his lines:

“I think most of what were fighting still today in the world is
incompetence. Most of what we're fighting is stupidity, and maybe a
little bit of opportunism. There is also the ominous, control-seeking large
corporate interests.”

The cover illustration invokes Alice on the threshold of
Wonderland, which chimes with the book's sub-title Adventures in
Search of Techno Utopia. Hogge writes with the small, quiet voice of
an Everyman, certainly no innocent, but in the spirit of the hacktivists,
struggling to navigate foggy and potentially dangerous roads to the
neon Utopia we are still promised. Gonggrijp again:

"We come in peace. We're not called Chaos Computer Club because
we cause chaos. If anything, a lot of our collective work has actually
prevented chaos by pointing out that maybe we should lay some decent
virtual foundations before we build any more virtual skyscrapers."

Barefoot into Cyberspace is available as a download and as a
paperback on Amazon.

Barefoot into Cyberspace: Adventures in search of techno-
Utopia by Becky Hogge illustrated by Christopher Scally ISBN
978-1-906110-50-5 (print) | 978-1-906110-51-2 (Kindle)

Becky Hogge is interviewed in Full Circle Side-Pod Episode
Ten: Dancing in Bare Feet
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Written by: I— Gnome) has a different way of doing
Ronnie Tucker (KDE) things compared with KDE (used in
Jan Mussche (Gnome) Kubuntu), but each version (or
Elizabeth Krumbach (XFCE) : ® derivative) has the same underlying
Mark Boyajian (LXDE) N P ) Ubuntu foundation. So, whether you
David Tigue (Unity) ' J install Kubuntu or Lubuntu, you're

: still using a version of Ubuntu; it's
just that the desktop looks, feels,
and works, differently. For each
Windows feature that I discuss, I'll
P attempt (with the help of my co-
authors) to show how things are
done using the four most popular
desktops as mentioned in my
introduction.

n this new section of Full
Circle, I'd like to show certain
features of Windows (XP in
this series of articles, as | feel
it's the most widely-used edition of
Windows) for the sole purpose of
showing beginners their *buntu
equivalent. | say *buntu as | will not
focus solely on Ubuntu - | will also
include Kubuntu, Lubuntu, and
Xubuntu, as they each have their
own way of doing things due to
each of them using their own
desktop manager (Ghome/Unity,
KDE, LXDE, and XFCE respectively).

C:\ AND MY
| DOCUMENTS

Every Windows
user is Familiar with
the ‘My Computer’
icon. Double-
clicking ‘My
| Computer’ on the
.| Windows desktop/menu presents a

| window showing your storage
i devices such as C:\ and any USB
media.

DESKTOP

Windows XP has its familiar blue
and green taskbar with a particular
style and layout on each window
that is opened. That is the Windows
desktop. Each version of Ubuntu
has its own desktop. Gnome (and Kubuntu has a similar option in its
Unity, the Ubuntu-only front-end to menu. Clicking the K button in your
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bottom taskbar will give you a
menu with tabs along the bottom.
Clicking the ‘Computer’ tab will
give you access to your storage
devices, just like in Windows' ‘My
Computer’. As does Ghome - you
simply click the menu Places in the
upper panel, followed by the
choice: Computer. Unity (which is
still under heavy development as |
write this) does it by clicking on the
‘Home Folder’ icon in the launcher
on the left hand side of the screen.
The icon is an orange file Folder
with a house on it. Ubuntu will
show the root of the hard drive on
the left hand side, along with other
storage devices and favorite
folders. In the right hand side of
the application, it will show the
folders inside the currently logged-
in users personal home directory.

Open the C:\, and you'll get a
list of folders including things like
‘My Documents’, ‘My Pictures’, and
so on. Linux (which is what Ubuntu
is based around) works quite
differently in this respect. The
Linux file system has a ‘root’ folder.
Think of that as your C:\ and your
Windows folder. In other words:
don't tinker with them! One folder
in root is called ‘home’. This home
folder is where each user gets their
own personalised folder - which

will contain all their stuff. You

could, in essence, think of your

personal home folder as your own oy——
P

C:\ drive, but, like Windows, your
home folder has a list of pre-made
folders for documents, video, and
so on. Again, like Windows, you're
free to create whatever folders
you like in your home folder.
Clicking K > Computer > Home will
give you the Kubuntu equivalent of
the C:\ drive. For Ghome, you click
on the menu Places again, this time
followed by Home Folder, and in
Unity it's done in the same way as
before - click on the ‘Home Folder’
icon in the launcher. Also you can

3 < & < Previous Folder

b C> Next Folder
| mar i+ Parent Folder

Alt+Left | F
Alt+Right

‘ Alt+Up
search through your files and e lmrmer e =2 =
L Desktoj ; B .
Folders by clicking on the ‘Dash K ot T T e oo

Root | 1) Trash Can
o Network Drives

4 Applications File System  Floppy Drive SanDisk
L\ 512 MBrncsyscen = Cruzer Micro:

512 MB
Home
— Filesystem
SHAR
==}

[l Fem_s4

Home' icon in the launcher. Once
inside the ‘Dash’, click on the ‘Files
and Folders' lens. It is located at
the bottom center of the ‘Dash’,
and looks like a piece of paper with
the top right hand corner folded
over. -

File Edit View Go Help

(TR | « | [ xutuntu
[ Deskiop -
W) K A

[ Tresh
Desktop  Documents Downloads Music

-l N a8

Public  Templates  Videos

L Backup

Lubuntu

Free space: 7.7 GB (Total: 8.3 GB)

8 files are listed.

File Manager

Lubuntu has no exact
equivalent to the Windows “My
Computer”. In Lubuntu, all access
to storage devices (network and
local devices) is done in the File
Manager (called PCManFM). The
File Manager, which is found by
clicking the Lubuntu logo on the
taskbar and selecting Accessories >
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File System
-
0| Network

i ] Documents

8items (32.0 KB), Free space: 3.9 GB

Ubuntu (Classic)
flications Places System ")
T8 Desktop
[Rg Documents
[ Music
[R5 Pictures
[F& videos

[F§ Downloads

El Computer
. 59 GB Filesystem

. /home

i5 Network

Home Folder

Ubuntu (Unity)
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File Manager, has two panes; all
available local storage locations
(drives and partitions) are displayed
in the left pane above the
horizontal divider.

For Xubuntu, you double-click on
the ‘Home' icon on your desktop to
gain access to your storage devices.
All equivalents to the My Computer
folder (or Home in *buntu) are
shown right.

PROGRAM FILES

Windows has a special folder
called ‘Program Files' and it's in
here that most Windows
applications are installed. Linux,
again, works differently. It installs
applications either in your home
folder (so that only you can run the
application), orin the root (so that
several users can run it), but, either
way, the application is installed to
hidden/restricted folders. Don't
worry about this for now as we'll
get to installing applications in a
later article, but suffice it to say
that you shouldn’t manually delete
applications as, just like in
Windows, it can cause instability.

EXPLORER

To open folders in Windows, you
double click an icon, and a window
appears. That window is called
Explorer. Windows Explorer lets
you look at your own computer and
the Files on it, just like Internet
Explorer lets you look at the
Internet. Each Ubuntu desktop has
its own equivalent of explorer.
Gnome has Nautilus. Clicking the
Gnome icon in the taskbar, then
System Tools > File Browser, will
show you the Gnome (Ubuntu)
equivalent of explorer, and it will,
usually, open by default in your
home directory. Unity does this by,
once again, clicking on the ‘Home
Folder' in the launcher on the left
side of your screen. You can go
back to the root and explore there
if you wish, but try and change
anything and it will ask you for a
password. This is to prevent
accidental deletion of critical files.
It’s also called the ‘root’ password.
Think of it as being like the
administrator password in
Windows. Once it's entered, you
have ultimate access to the Ffile
system and could, in theory, wreak
havoc. Kubuntu has its KDE
equivalent of explorer called
Dolphin; it's found by clicking K >
Computer > Home (or K > Favorites
> File Manager) on the taskbar.

Kubuntu

S 4b system Settings

0 Run Comman: ...

9 Home

@ Networlc
-

ulati

'3 @ B v 4 (@ /Mome/markb

|[#) markb

Desktop ‘ ‘ |
:'_"i Trash Desktop Documents Dqg
G Applications

1 Rout a . |
L Backup1 Pictures Public Te
L\ 512 MBFilesystem A

; Home

L shar

i Fom_s4 Lubuntu

i xubuntu - File Manager
File Edit View Go Help

[SETTN (bt
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"R

ﬁ Trash
Desktop Documents Download

W) uE

Templates Videos

) File System

-
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Lubuntu (using LXDE) has the
File Manager, and it's found by
clicking the Lubuntu logo on the
taskbar and selecting Accessories >
File Manager. Xubuntu (XFCE) has a
file manager called Thunar - which
can be accessed by clicking on the
Xubuntu mouse icon at the top left
your your screen and going to
Accessories > File Manager. Like
Windows, you click the X icon in the
corner of the window to close it -
with the other two icons letting you
maximise and minimise each
window. With Unity, the buttons to
Close, Maximize, and Minimize, are
located on the top left of the
window when it is not full-screen,
but, once the window has been
maximized, the buttons will be

hidden in the main panelin the top
left hand of the screen. You have to
move your mouse pointer up to the
panel for the buttons to reveal
themselves.

We could devote an entire issue
to the items within Explorer and
the *buntu equivalents, but have a
look at the menu items in your
desktop’s windows. Most of the
items are quite self-explanatory,
and I'm sure we'll touch more upon
them in future articles.

Next issue, we'll talk about the
*buntu equivalents for the ever
familiar Control Panel and Device
Manager.

kubuntu®ubuntu®
xubuntu® Lubuntu®
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MY STORY

Written by Kavinda Bandara

'm a doctor in Sri Lanka,
currently waiting till I get my
first appointment.

| had my First experience with
GNU/Linux when | came across
Redhat, which was used by one of
my cousins, in 2004. Then | got to
know about Ubuntu through him,
and he made me get free CDs of
Ubuntu and Kubuntu. It was in
2006, when | was a med student;, |
tried it on my home computer, but
the experience was not that nice,
as | didn't have Internet, hence no
further source of information.

| had my laptop in 2007. It was
an HP Pavilion DV9000 with 1 GB
RAM. The default OS was Vista, and
you can imagine the picture. It was
good at first sight, but became
creepy and annoying whenever |
used it. And it was consuming the
majority of my RAM and 160GB
hard disk, so | wanted a solution.

| again came across Ubuntu, and
learned that it had improved a lot,
with frequent updates, upgrades,
and new versions. So | requested

the CD in shipit, and could get
them delivered to home within a
couple of weeks. First, | tried it as a
live-CD, and, once | was
comfortable enough, I installed it
as dual boot with Vista. | had a big
learning curve ahead, so | waded
carefully, and took my time to
repeatedly go through the try-
break-mend-learn cycle. When |
could get Internet later, as it was
then somewhat affordable, | could
move fast with great forums and
support pages maintained by
experts. Ultimately, | even could
identify the script for prepaid
Internet connections of my ISP,
which was not available according
to their customer care!

| continued to move with each
version of Ubuntu, which became
simpler, user friendly, and
attractive every time. Every time it
was a clean install, but I stayed
with dual boot. When 10.10
arrived, | decided to give up Vista. |
upgraded to 11.04, but, since it had
many bugs, | reverted back to
10.10. Now I'm fully comfortable
with Ubuntu and always
recommend it to others. And | have

started a blog on Ubuntu, and | try
to continue it - even with my busy
schedule.

Now, my friends find my laptop
being a “hotspot” to have a peep
in, but still many stay with
Windows. Main fear they have is
the learning curve ahead of them.
But | was able to change one of
them to Ubuntu, and he found it so
easy that he stayed with it. Also,
my girlfriend loves my system, and
knows how easy it is. My sister
recently requested dual-boot with
Ubuntu in her new laptop.

The drawbacks | came across
were many. We had some software
that need windows to run, but |
could manage with alternative
tools, WINE, or with a virtual
machine with windows XP.
And the false belief of
being difficult-to-use
is another deeply
established idea, that
is strengthened by
the market sellers and
the authorities we have.
So, they tend to buy an
expensive OS, or have a
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pirated version and spend some
more money on software, specially
on virus guards. Reliability is
another issue for them, but not for
me. This is far more reliable than
Windows.

| would like to have a good
organization/forum/community
such as Ubuntu community in Sri
Lanka, as it would solve many
problems we, the users and the
newcomers, have. Thisis a
community product after all, right?
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MY STORY

Written by Jim Roche

y history with
computers dates back
to the 1970's starting
with using Fortran on
a Honeywell mainframe at
University. This was followed by
Basic on HP minicomputers and
afterwards some experience with
IBM mainframes and DEC VAX and
PDP systems. My first personal
computer was an Apple lle running
CP/M followed by adventures with
the DEC Rainbow before moving on
to IBM PC XT, DOS and later
Windows. | can actually remember
Windows 1.0 becoming available in
1986 and being very unsure as to
it's acceptance. Around the same
time, | had a Mac SE and an Apple
Laserwriter for desktop publishing.
In short, | worked with multiple
hardware platforms, various
operating systems, many different
applications and became quite
comfortable with all of them.

The creation of Linux in the
early 90's was of some interest to
me but | admired it from afar as |
was busy with other things. Ubuntu
was the First distribution | ever
used and that was the Feisty Fawn

release in 2007. However, | always
installed them in a dual-boot
arrangement and never really
committed to Ubuntu. In the
meanwhile, | had pretty much
reached frustration levels with the
various Windows versions
and Vista was the last
straw. It was time ;
to commit: |
decided to
dedicate an
IBM T42 laptop
(Pentium
Mobile 1.7GHz,
1.GB RAM, '
60GB HDD, 15
XGA+(1400x1050)
TFT LCD, 64MB ATI
Radeon 9600, CD-
RW/DVD, 802.11b/g wireless)
to Ubuntu and did that with Lucid
in 2010, followed by Maverick and
Natty. As | moved through the
various releases over the years, the
improvements seemed slow and
steady rather than dramatic to the
point where a Natty clean install
went without a hitch. Previously, |
had tried the upgrade route from
Maverick to Natty but had
problems | was unable to resolve.

Of course, Natty arrived with
Unity and that caused me some
bother. My comment in Full Circle
#49 was "l don't like it.
Immediately after installing Natty, |
ried to use it for a couple
~ N\of hours but found it
inconvenient and
intrusive. Things

. o do. After a
'— hile, I was able

out, but it still took
me longer to do
anything. I was glad to have the
option to switch back to "classic"".
Since then | have taken the time to
switch to Unity and now use it full
time with fFewer and fewer issues.
There are still some odd things like
the inability to move the Launcher
and the consequent "conflict" with

the Back button on Firefox.

Having worked with Maverick
and Natty daily for over a year, |
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can see no reason not to
recommend Ubuntu to other
people although | am frequently
surprised by the number of people
who know little of Linux and less of
Ubuntu. However, given the costs
associated with the Windows
route, it makes a lot of sense to
make the switch. The main concern
is the compatibility issue with
applications running on other
systems. Unfortunately, that
means compatibility with MS
Office and web sites optimized for
or requiring Internet Explorer.
Again, these issues are very minor
in all practical applications.

At this point, | have one other
PC running Windows 7 mainly for
Adobe Lightroom photo
management software. As soon as
there is an equivalent Linux
product, that will be the end of
Windows on any of my PC's. | am
waiting for the latest release of
Darktable with great interest.

| also have an older PC running
XP which is used for occasional
browsing and this will be my next
upgrade project.
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Last month's question was:

What age do you think the average
Linux user is?

... and what is your age?
I "
15-19:'
20-291
3o 39 1a6 a9 < [ oo ol s
20-29 146  43% i 20-29 84  43%
30-39 137 403 40-49 30-39 93  40%
40-49 31 9% _ 40-49 54 9%
50-59 11 3% 50-50 | 50-59 35 3%
! 60-69 2 13 : 60-69 34 1%
60-69 | 70+ 2 1% 60-69 | 70+ 14 13
70+ 704
0 29 58 87 116 145 174 0 19 38 57 76 a5
gy | think this is the age range really care about their choice of Windows is predominantly used. just stick with the preinstalled
where the majority of Linux 0S, and only know Windows or (20-29) Windows, which just works. (20-29)
users are today -- most are Apple OS. (30-39)
college students and young gy |see more and more young
professionals. (20-29) d1 Silver Surfers want a fast, easy, people using Linux, whereas |
dependable PC! (60-69) think most of the older people
141 Young people might have
more knowledge to separatea jg Visual observation at Ohio T .
computer from an OS, and they Linux Fest (40-49) UG Gz [ (e o el Ui
are willing to try something new. . "
(20-29) 11 When they become aware of Did you upgrade your current *buntu to
l X y the Microsoft tax! (30-39) 11.04? If so, how? If not, why? Or did you do a
11 No longer caught up in fads . 2
and peer pressure. (40-49) gy Thatwas the age | got started, fresh install?
and older people usually want To ai to: htto:// /huU
1 limagine younger users don't the corporate jobs. This means O give your answer, go to: ntip://g00.9/huina
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Written by Luca Bergesio

Synergy

s per the results of the

latest research, working

with more than one

monitor can increase
your productivity by 9 to 50
percent. Often, modern PCs have
two video outputs, but what can
we do if we have a graphics card
with a single output and we want
to connect two or more monitors?
In this situation, it is not possible to
connect the second screen without
changing the video card. A solution
can be to connect the second
monitor to another PC so you can
work with two screens, but also on
two different computers with two
sets of keyboard and mouse. The
solution is Synergy (http://synergy-
foss.org/). Synergy is a free and
open-source software released
under the terms of the GNU
General Public License. With this
software, you can share your
mouse and keyboard between
multiple computers, where each PC
has its own display.

The First version of Synergy was
created in May 2001 by Chris
Schoeneman; it was written in C++
and it worked with the X Window

System only. In 2009, Chris
Schoeneman, Sorin Sbarnea, and
Nick Bolton started a fork of
Synergy named Synergy+ with the
aim of making a cross-platform
software. Now, this fork project
has been merged back into
Synergy. The latest stable version is
1.3.7, while 1.4.3 is a beta version.

Synergy uses a local area
network and it can share mouse,
keyboard, and clipboard between
two or more PCs. Another
advantage is that Synergy is
supported on Windows, Mac OS X,
and Linux, so each PC can have a
different operating system. In this
manner, you do not need emulators
or virtual machines, each program
runs on its operating system.
Clipboard works with a small ftp
client-server application within the
main program which allow you to
copy and paste between PCs,
regardless of their operating
systems. Redirecting the mouse
and keyboard is as simple as
moving the mouse off the edge of
your screen. Key presses will be
delivered to whichever computer
the mouse-pointer is located in.

The program is based on a
client-server architecture. The
server defines which screen-edges
lead to which machines, and share
its mouse and keyboard. Clients are
connected to the server to offer
the use of their desktops. With
Synergy, you have a multiple
monitor system with the
computing power of many
computers, and you can work on
many operating systems
concurrently.

You can download the program
from http://synergy-
foss.org/download/. Here is an
example of a configuration File for
the server (two PCs, pc1 on the

(D Synergy

i .I_.I_

right and pc2 on the left, both in
front of you).

section: screens
pcl:
pc2:
end
section: links
pcl:
left = pc2
pc2:
right = pcl
end

If you do not like to write config
files, you caninstall a GUI, for
example Qsynergy
(http://code.google.com/p/quicksy
nergy/). The version for Windows
has the GUI within the installer. To
run the programs use these

Just move your mouse from one screen to another!

L _|_|_._IIII_ FERE s
“_. a7 |

8

Cllent 1

Mo keyboard or mouse Kevboard and
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| mouse is shared Mo keyl

Client 2

yoard or mouse
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REVIEW: SYNERGY

commands:
client: synergyc ip_addr pcl

server: synergys --config
filename.conf

The main problem of Synergy is
security, if you work on a non-
trusted local network. In fact,
communications are not encrypted
and key presses, mouse
movements and clipboard contents
sent to Synergy clients can be
easily sniffed on network traffic.
You can solve this problem by
configuring an SSH server so all
communications are tunneled
through a secure encrypted
connection. In this page there is a
guide to configure Synergy with
SSH: http://synerqgy-
foss.org/pm/projects/synergy/wiki/
Security

For my own experience, | use
Synergy every day at work, where |
have a laptop and two servers. The
laptop has its own screen and a
second monitor, while each of the
servers has a video card with only
one output. | use all PCs with a
keyboard and a mouse connected
to one of the servers. When | need
a Windows program, | do not need
emulators or virtual machines, |

simply restart the laptop in
Windows and | can work as before,
with my four “monitors-PCs”
system.

Score: 9/10

Good:

» Works on Windows, Linux, and
Mac OS X, and allows
communications between them

* Clipboard works between PCs,
regardless of their operating
system

* You can connect several PCs (and
monitors), and control all of them
with only one keyboard and mouse
* No latency for mouse movements
and key presses

Bad:

« Communications are not
encrypted

» Sometimes does not write some
special character on a client, even
with the same operating system (é,
é, 4, etc.)

* If the PC with the server is locked,
you cannot use client PCs
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A PLEA ON BEHALF OF THE
PODCAST PARTY

As you often hear in the podcast, we're calling
for opinion topics for that section of the show.

Instead of us having a rant about whatever
strikes us, why not prompt us with a topic and
watch for the mushroom clouds over the
horizon! It's highly unlikely that the three of us
will agree.

Or, an even more radical thought, send us an
opinion by way of a contribution!

You can post comments and opinions on the
podcast page at fullcirclemagazine.org, in our
Ubuntu Forums section, or email
podcast@fullcirclemagazine.org. You can also
send us a comment by recording an audio clip of
no more than 30 seconds and sending it to the
same address. Comments and audio may be
edited For length. Please remember this is a
fFamily-friendly show.

It would be great to have contributors come on
the show and express an
opinion in person.

Robin

y
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LETTERS

Every month we like to publish some of the emails we receive. If you would like to
submit a letter for publication, compliment or complaint, please email it to:
letters@fullcirclemagazine.org. PLEASE NOTE: some letters may be edited for space.

FoxPro

hat I needis a

substitute for

Microsoft FoxPro -

the database
program Microsoft bought from
the originator, and then effectively
buried. | use FoxPro to run a big
youth baseball league. | don't need
a big multi-user relational database
program: | am the only user. But
Fox has a great structure for what |
do, and | hate to leave it behind in
order to switch to Linux. Does
anyone know of a good substitute
that does not require learning an
entire new database manipulation
paradigm?

Bob Nelson

Ubuntu To The Rescue!

'm an Ubuntu user now for 3
years. | still work on Windows
systems. The other day, |
showed up at a friend’s house
who was receiving the “blue screen
of death”. | attempted to get the
machine to boot but kept receiving

“do you want to format the drive?”
message. | took the hard drive
home and decided to take a look at
it with my Ubuntu system. Guess
what, one pop up window - and I'm
viewing the hard drive content.
Back to my friend’s new machine
now, and trying to copy XP external
hard drive data to a win7 system,
and can't get past the permissions.
After researching on the net, | saw
advice to use Ubuntu cd to copy
files. Why is it that Ubuntu has to
bail out Windows all the time?
Anyways, with Ubuntu, I'm able to
copy his recent Files off of his hard
drive, and he is one happy camper.
The more | use Ubuntu, the more
I'm happy with it.

Bob K

Genealogy Addition

his page,
www.fileyourpapers.com,
has some great ideas
concerning filing
paperwork so that there is a
minimum of Fuss in finding what
you're looking for. For Gramps, try

the method shown for PAF - | think
the numbering schemes are the
same.

Dave Rowell

Garmin GPS

would like to see an article on
“How to Update my Garmin
GPS” - using Ubuntu or any
GNU/Linux distribution.
Garmin seems to be stuck on using
MS products, and forcing their
customers to do the same. Also, |
think a small article in each month's
issue about some vendor that all of
us should write to requesting that
their product be made compatible
with GNU/Linux, preferably
Ubuntu. Maybe starting with
Garmin, TurboTax, and Netflix -
even though Netflix is going down
the tubes. | stopped using
TurboTax and now use TaxSlayer.

Not bad for a 75-year-young
avid Ubuntu user.

Jim Bainter
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Join us on;

foW facebook.com/fullcircle
LY magazine

twitter.com/#!/fullcirclemag

linkedin.com/company/full-
circle-magazine

ubuntuforums.org/forum
display.php?f=270

If anyone out there can help Jim
with his Garmin GPS, please drop me
an email with info, or an article, and
I'll pass it along. - ED

First Cousin - Twice
Removed

want to thank the editors,
cast, and crew, and especially
Dave Rowell, for the
review/article on GRAMPS in
FCM#51. It motivated me to get
off my duff and begin my own
family research. | look forward to
FCM#52, and the article showing
how to get started. | have begun
using GRAMPS, but, it is rather
counter intuitive, and I'd rather
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LETTERS

spend my limited time doing
research than learning how to
use the program. I'm
starting to get
overwhelmed by the
amount of family
data thatlam
finding, and I am
just now

starting to
correlate that
data, and |

think this is
where GRAMPS
is going to be a
huge asset.

It's like the
commercials fFor
ancestry.com that say
“You don't have to know
what you're looking for;
you just have to start looking!” One
of their commercials is of a woman
who says she found out her
grandparents lived next door to
the Wright Brothers and she says,
“How cool is that?” Well, | think |
can top that. How about knowing
all your life from family folklore
that you are related to Mark Twain
(Samuel Langhorn Clemens), but
never knowing the exact
relationship. Then you find very
concrete evidence, without much
searching or cost, that Mark Twain

was actually your grandfather's
first cousin, and realizing at that
point that Mark Twain is
your first cousin-twice
removed. That's the
equivalent of
realizing that Tom
Sawyer,
Huckleberry Finn,
and even Becky
Thatcher are
really your
cousins and that
the former slave,
Jim, is your
favorite uncle.
“How super-duper
COOL is that?”

If you are part of my
really large Family,
especially if you are on the
British side of the pond, please go
to genforum.com and look for the
thread 'Clemons in Virginia', and
see what we have come up with so
far, and add anything to it that you
can. It is evident that there is an
African-American branch to the
family. How and when did that
branch occur? Bruce Spingsteen's
saxophonist, Clarence Clemons
recently died. Was he a close
cousin also? Inquiring minds (mine!)
want to know. | can't speak for
everyone in my fFamily, but, for me,

that would be almost as huge as
discovering that I'm related to
Mark Twain.

John D. Clemons
jclemons@naxs.com

Upgrading 11.04

quick remark about the
article "Upgrading From
11.04" on page 42 of
FCM#53:

When upgrading to a newer
version, or re-installing the same
version, or installing a new version
it is always good to back-up your
data. But, when you are really
careful and know what you are
doing it is not necessary. So, if you
don't have means to make a back-
up outside your computer read on.
There is, however, one thing you
need to have done already: give
your home folder a separate disk
or partition. In other words don't
let it be inside the installation of
your OS. Have a disk or partition
for"/", one for "/home", and maybe
others for "/var", "/usr" or
whatever.

During installation of a new
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version or re-installation of your
present OS you have to make sure
you choose the right answer when
the installer comes to the question
where you want to install. Don't
choose entire disk, but choose
something like: Manual, or choose:
Let me decide. (I don't have the
right text here at the moment).
This way you can install the OS on
the same partition as you have
done before. Simply point to the
old "/" partition, give it the name
"/" again and format it. Do the
same for the other separate
partitions (var, usr, ...) but for
"/home" you only point to the
partition and DON'T format. This
way it will be included in the
installation but you will keep your
data.

| have done it this way for many
(re-)installs and never lost a thing. |
must say | do make back-ups
regularly (every week) and before
a new install. But I've never had to
use the back-up because | never
lost my data.

Jan Mussche.
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Compiled by Gord Campbell

If you have Ubuntu-related questions, email them to:

questions@fullcirclemagazine.org, and Gord will answer them in a future
issue. Please include as much information as you can about your problem.

| am using Evolution for
my email. | cannot move
an email from Junk Mail
to another folder, it just

makes a copy of the message, still
in the Junk Mail folder.

(Thanks to Barryin the
Yahoo Ubuntu Linux
group) Mark it as 'not
junk' before trying to

move it.
| am using the long-term
version of Ubuntu, but |
would like to have later
version of applications.

Have a look at this
article in the Community
Docs:
https://help.ubuntu.com

/community/UbuntuBackports

I'm looking for Linux
software that does what
the following software
does for Windows:

EMCO MoveOnBoot 2.2.5
Unlocker 1.9.1

XPlite/2000Lite

nLite

Faronics Anti-Executable 3.40 (or)
Faronics Deep Freeze 6.62
DriveShield Plus

Most of those are not
required for Linux.
Remastersys is similar to
nLite or Deep Freeze.

In Libre Office or Open
Office, how can | find and
replace paragraph
breaks?

(Thanks to David Shaw
in the Yahoo Ubuntu
Linux group) In the Find
and Replace dialogue,
click on "More Options." Tick the
'Regular expressions' box. A list of
common regular expressions can
be found at
http://help.libreoffice.org/Commo
n/List_of Regular Expressions

For instance, to find a tab, or

replace with a tab, use \tin the
relevant box. Paragraph breaks are
found/replaced with a 'S’ symbol.
Should you actually want to
find/replace a dollar symbol, you
need to use '\$', or switch regex
off.

| have 11.04 installed

without problems for

about 2 weeks now. |

changed something in
compiz, and now, when | started up
the computer, there is no menu on
the left or the top.

Follow this
troubleshooting guide:
http://www.tuxgarage.c
om/2011/04/missing-
top-and-side-panels-in-unity.html

| want to buy a monitor -
what's compatible?
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Any monitor should
work just fine, as long as
your PC has the right
connector for it

(HDMI/DVI/VGA/Displayport).

Wind Mobile offers a
mobile broadband service
with the E1691 device
from Huawei. How can |

use it?

http://hireknowledge.ca
/pdf/Tutorial Huawei E
1691 Linux v1.0.pdf

This tutorial might also provide
hints For people with other
Internet sticks on other wireless
networks.

| installed Ubuntu 9.04
from CD to an old
computer | had lying
around. | tried installing

versions 10 and 11, but the
computer ran very very slowly,
while with 9.04 it's pretty good.
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Q&A

Trying to do sudo apt-get udpate
fails on everything because it can't
find the files online. | read that
version 9.04 is not supported and
even these old Files are not
available anymore. What should |

do?
Try the current version
of Xubuntu or Lubuntu.

| have an AMD Radeon
HD5770 graphics card.
The GPU cooling fan
always runs at full speed,

regardless of GPU load. It makes
my PC sound like a jet-plane taking

ofF.
It turned out that

installing the FGLRX
driver solved the fan
issue.
| use Ubuntu 10.04. My
HP B110A prints fine, but
it won't scan.

Install the latest version If | download the 64 bit
of HPLIP: 10.10, and install from
the live usb, will it

"overwrite" the old 32 bit
install?

sudo add-apt-repository

ppa:hplip-isv/ppa Yes
sudo apt-get update A
sudo apt-get install hplip

| can no longer run
| like the Xfce desktop Update Manager because
environment, but the only I'm getting the "Not

problem is that | can't run enough free disk space"
any programs because | problem.
have no idea how to give it

permission to run. For example, I've Running the command:
installed a .jar file and have Java 6
Runtime installed, but | don't know

how to give it permission to run.

df -h

It turns out that a jar
doesn't have to be
tagged as executable to

showed that only the boot
partition was low on space. Run

he f ldrun. I;rom 'Ir']erfmn.al, (tsz Synaptic Package Manager to
to the Folder where the jar is, then completely remove old kernels,

issue this command: then:

java -jar

sudo update-grub

(where jar is the name of the file).
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Your chance to show the world your desktop or PC. Email your screenshots and
MY D ES KTO P photos to: misc@fullcirclemagazine.org and include a brief paragraph about your

desktop, your PC's specs and any other interesting tidbits about your setup.
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= DWTV Asia+ |l
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# Fishing & Huntin m U‘StEI
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= GERTY

Playing: Discovery Science

This is my screenshot on
my laptop, it is an HP
@ 18 s = (nilardel Jf " 3 R from 2006, but works

GErellM System Monitor

This is my desktop screenshot. My OS is a homemade nicely to surf the Internet,

mixture from Debian base, Ubuntu, Back Track, Hymera, write mail, read

and a lot of extra repositories. I'm using a lot of software newspapers, and use the

for astronomy, radio communication, and spectral bank. I like Unity - easy to

analysis. use on the laptop - and |
use gkrellm to monitor.

PC specs:

Processor Intel Celeron 1.6Ghz Per Gylterud

1G Ram

Alternating Gnome with OpenStep and BlackBox

Bratu Florian
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MY DESKTOP
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Here is my current Ubuntu 11.04 desktop.
I am running Ubuntu 10.10 on a Dell Vostro laptop -

PC Specs: with Intel core 2 duo, 2GB RAM, 160GB HDD,

RAM 2GB ) resolution is set to 1280*800. | have been using

Processor core-i3 2.2GHz. Ubuntu since 8.04, and, since then, | am in love with

Resolution:1366x768 it. | am using Ambiance theme with wallpaper from

Laptop: lenovo thinkpad E420 Ubuntu-art.org. The bottom dock is aligned using AWN
, . _ manager; for the gadgets | am using screenlets. My

Simple efficient ubuntu classic desktop. | use Avant friends ask me which operating system is this!! (open

Window Navigator, Divergence IV - “A New Hope” mouthed).

GTK2 theme with single panel at the top for better

efficiency to do my daily tasks. Nityanand Sharma

Nilimoy Buragohain
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Full Circle Team

HOW TO CONTRIBUTE

Editor - Ronnie Tucker

ronnie@fullcirclemagazine.org
A Webmaster - Rob Kerfia
We are always looking for new articles to include in Full Circle. For article admin@Fullcirclemaqazing.orq
guidelines, ideas, and for issue translation, please see our wiki: Comms Mgr - Robert Clipsham
http://wiki.ubuntu.com/UbuntuMagazine mrmondav@Ful‘larcler-naqazme.orq
Please email your articles to: articles@fullcirclemagazine.org Podcast - Robin Catling
) podcast@Ffullcirclemagazine.org
~ Editing & Proofreading
If you would like to submit news, email it to: news@fullcirclemagazine.org ML e
Lucas Westermann
Send your comments or Linux experiences to: letters@fullcirclemagazine.org Geife Camp.bell
Robert Orsino
Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org
Questions for Q&A should go to: questions@fullcirclemagazine.org 7 il g0 oLl lso Camerigsl e
many translation teams around the
Desktop screens should be emailed to: misc@fullcirclemagazine.org weie £ e Thorsten LI et EnE
current Full Circle logo.
... or you can visit our forum via: www.fullcirclemagazine.org h ?
) Deadline for Issue #55:

Sunday 06th Nov. 2011.

Release date For issue #55:
Friday 25th Nov. 2011.

FULL CIRCLE NEEDS YOU!

A magazine isn't a magazine without articles and Full Circle is no exception. We need
your Opinions, Desktops and Stories. We also need Reviews (games, apps &
hardware), How-To articles (on any K/X/Ubuntu subject) and any questions, or
suggestions, you may have.

Send them to: articles@Ffullcirclemagazine.org
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